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CHAPTER 1

Introduction
In this chapter

• Introduction

• Features

• Specifications

• Reference View - Front Card

• Reference View - Back Card

• DIP Switches

• Connector Pin-outs
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Introduction

The RTS MCII-e System controller card is the third generation controller for the ADAM 
Intercom System. Designed to replace the ADAM-MC, it adds a number of key features. 
Adding Ethernet connectivity between the ADAM Intercom and the PC running AZedit, 
the new controller can support up to 35 simultaneous AZedit sessions (32 using Ethernet 
and up to 3 using serial ports). Using a pair of MCII-e controller cards will provide full 
redundancy with seamless automatic change-over upon failure.

The speed of Ethernet, combined with expanded memory, allows the card to fully support 
large matrices with reduced setup file download time.

As with all ADAM™ Intercom family products, the MCII-e card supports all standard, 
hot-swappable, and configurable features through the AZedit configuration software. It is 
fully compatible with existing ADAM systems and cards, including AIO-8, AIO-16, AES-
3, and RVON VOIP interfaces

*The New MCII-e System Controller card is only for use in the ADAM Matrix Intercom System and 
cannot be intermixed with older ADAM master controllers in a given frame.

Features

Installation: The MCII-e System Controller card is hot-swappable and 
installs into slots 19 or 20 in an ADAM™ Intercom System. 

Trunk Capable: The MCII-e System Controller card supports ancillary data 

control for use with Telex® Intelligent Trunking.

Ethernet Compatible: Fully Ethernet capable. The MCII-e provides a single RJ-45 
connection for use with a 10BASE-T or 100BASE-TX compli-
ant and network. Each system controller has its own IP address 
network access.

AZedit Configurations: The MCII-e can connect to AZedit via Ethernet or Serial (RS-
232) connections. Also, the new Intercom Sizing Wizard in 
AZedit makes configuring the new system controller card eas-
ier than ever.



Specifications
Controls: Reset push-button switch, general indicators, an LED module for 
advanced monitoring features and for gathering additional card 
information.

Specifications

Power
7.5W/ 1.5A @ 5V

Physical
5.687” (144.45mm) W x 11.024” (280.01 mm) L

Connectors
SCSI connector via backcard
RJ-45 Ethernet via backcard

Miscellaneous
4 Mbytes of Code Flash
32 MB of SDRAM
8Mbytes Configuration Flash
5
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System Diagram

Figure 1. System Diagram - MCII-e Master Controller
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Reference View - Front Card

Jumper Setting

For 
Programming 
Use ONLY!
J801 -
Pins 1 & 2 must
be shorted.

Pins 3 & 4 must
be shorted.
Reference View - Front Card

Figure 2. MCII-e System Controller Card Board view.
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Figure 3. LED Descriptions for the MCII-e



Reference View - Back Card
Reference View - Back Card

DIP Switches

DIP Switch 1: Debug Only! Must be in OPEN position.

DIP Switch 2: Sets the baud rate for the AZedit serial connection via J1. By 
default, AZedit is set for COM 1 and 38,400 kbps (38.4K). The 

Figure 4. Back Card 

Figure 5. Dip Switch SE02

ETHERNET
J1

J2

LINK

ACT

RJ-45 Ethernet Connection

68-pin SCSI Connection

ON

SE02

1 2 3 4 5 6 7 8

Closed

Open
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baud rate set in AZedit must match the baud rate setting of 
the Master Controllers in ADAM.

DEFAULT = OPEN
OPEN = 9600
CLOSED = 38.4k Baud

DIP Switches 3, 4, and 5: Reserved, keep in OPEN position.

DIP Switch 6: Debug Only! Must be in OPEN position.

DIP Switch 7: Determines Master/Slave Frame in a multi-frame 
system.

DEFAULT = CLOSED
OPEN = Slave Frame
CLOSED = Master Frame

DIP Switch 8: Debug Only! Must be in OPEN position.

Warning: DIP Switches 1, 6, and 8 should always be left in the OPEN position. These are 
reserved for debugging and can have unintended consequences.



Connector Pinouts
Connector Pinouts

AZedit #1

68-pin Master 
Controller

J-1 of 
XCP-ADAM-MC Assignment 2W

1 1 RS485 TX/RX-

3 2 RS232C RX

37 3 RS232C TX

4 4 RS422 TX-

2 5 Ground

2 6 Ground

38 7 RS422 TX+

35 8 RS485 TX/RX+

9

Trunking System

68-pin Master 
Controller

J-2 of 
XCP-ADAM-MC Assignment 2W

5 1 RS485 TX/RX-

36 2 Ground

6 3 RS232C RX

4 Not Used

41 5 RS422 TX+

39 6 RS485 TX/RX+

36 7 Ground

40 8 RS232C TX

7 9 RS422 TX-
11
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UIO-256/PAP/LCP

68-pin Master 
Controller

J-3 of 
XCP-ADAM-MC Assignment 2W

8 1 RS485 TX/RX-

9 2 Ground

3 Not Used

4 Not Used

44 5 RS422 TX+

42 6 RS485 TX/RX+

9 7 Ground

8 Not Used

10 9 RS422 TX-

General Purpose

68-pin Master 
Controller

J-4 of 
XCP-ADAM-MC Assignment 2W

11 1 RS485 TX/RX-

43 2 Ground

3 Not Used

4 Not Used

46 5 RS422 TX+

45 6 RS485 TX/RX+

43 7 Ground

8 Not Used

12 9 RS422 TX-



Connector Pinouts
General Purpose

68-pin Master 
Controller

J-5 of 
XCP-ADAM-MC Assignment 2W

11 1 RS485 TX/RX-

14 2 Ground

3 Not Used

4 Not Used

5 Not Used

47 6 RS485 TX/RX+

14 7 Ground

8 Not Used

9 Not Used

General Purpose / Bus Exp.

68-pin Master 
Controller

J-6 of 
XCP-ADAM-MC Assignment 2W

15 1 RS485 TX/RX-

48 2 Ground

3 Not Used

4 Not Used

5 Not Used

49 6 RS485 TX/RX+

48 7 Ground

8 Not Used

9 Not Used
13
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General Purpose / Bus Exp.

68-pin Master 
Controller

J-7 of 
XCP-ADAM-MC Assignment 2W

16 1 RS485 TX/RX-

17 2 Ground

3 Not Used

4 Not Used

5 Not Used

50 6 RS485 TX/RX+

17 7 Ground

8 Not Used

9 Not Used

General Purpose / Bus Exp.

68-pin Master 
Controller

J-8 of 
XCP-ADAM-MC Assignment 2W

18 1 RS485 TX/RX-

51 2 Ground

3 Not Used

4 Not Used

5 Not Used

52 6 RS485 TX/RX+

51 7 Ground

8 Not Used

9 Not Used



Connector Pinouts
AZedit #2

68-pin Master 
Controller

J-9 of 
XCP-ADAM-MC Assignment 2W

1 Not Used

19 2 Ground

20 3 RS232C RX

4 Not Used

5 Not Used

6 Not Used

19 7 Ground

53 8 RS232C TX

9 Not Used

AZedit #3

68-pin Master 
Controller

J-10 of 
XCP-ADAM-MC Assignment 2W

1 Not Used

67 2 Ground

21 3 RS232C RX

4 Not Used

5 Not Used

6 Not Used

67 7 Ground

54 8 RS232C TX

9 Not Used
15
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General Purpose
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Assignment Signal

22 1 MI (0) Logical Input (0)

23 2 MI (1) Logical Input (1)

24 3 MI (2) Logical Input (2)

25 4 MI (3) Logical Input (3)

26 5 MI (4) Logical Input (4)

27 6 MI (5) Logical Input (5)

28 7 MI (6) Logical Input (6)

29 8 MI (7) Logical Input (7)

30 9 Ground Ground

31 10 Ground Ground

32 11 Ground Ground

33 12 Ground Ground

34 13 Ground Ground

55 14 MO (0) Logical Output (0)

56 15 MO (1) Logical Output (1)

57 16 MO (2) Logical Output (2)

58 17 MO (3) Logical Output (3)

59 18 MO (4) Logical Output (4)

60 19 MO (5) Logical Output (5)

61 20 MO (6) Logical Output (6)

62 21 MO (7) Logical Output (7)

63 22 Ground Ground

64 23 Ground Ground

65 24 Ground Ground

66 25 Ground Ground



CHAPTER 2

Configuring the MCII-e
In this chapter

• System Requirements

• Ethernet Setup for the MCII-e System Controller

• Download Firmware for the MCII-e System Controller
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System Requirements

Before you configure your MCII-e System Controller card, verify the following items are 
updated:

• AZedit v 2.08.01 or later

• AIO-8 v 10.3.4 or later

• AIO-16 v 1.0.0 or later

• Periph-IIe, requires DBX v1.14.0 or later

NOTE:  Field upgrade of DBX will requires Boot Code upgrade to version 0.0.3.  If the 
Boot Code is not upgraded, the DBX card will not work with the MCII-e. Refer to DBX 
Boot Code Upgrade (pn 38110-472.

Ethernet Setup for MCII-e System Controller

Set the IP Address for the MCII-e System Controller 

NOTE: The PC must be running version 2.08.01 or later of AZedit and have an Ethernet 
card installed. The MCII-e can support up to 32 concurrent sessions of AZedit on Ether-
net.

Verify the MCII-e is connected to the PC using a RS232 (ADAM standard) cable. Connect 
J1 on the XCP-ADAM-MC to the COM port on the PC.

NOTE: For more information on Network Basics, see the Basic Networking Guide found 
at our website (http://www.telex.com/Intercoms/files.nsf/sitemap#Brochures), under 
Applications. 

If there are two controllers, they must each have their own unique IP Addresses (different 
from each other and any other devices sharing the same network).

To connect the Active MCII-e to the PC with a serial cable, do the following:

1. Open AZedit.
The Keypanels/Ports screen appears.

http://www.telex.com/Intercoms/files.nsf/sitemap#Brochures
http://www.telex.com/Intercoms/files.nsf/sitemap#Brochures


Ethernet Setup for MCII-e System Controller
2. From the Option menu, select Ethernet Setup.
The Ethernet Setup screen appears.

3. In the IP Address field, enter the IP Address for the current MCII-e System Controller.

4. In the Network Mask field, enter the Network Mask number for the current MCII-e Sys-
tem Controller.

5. Where appropriate, in the Default Gateway field, enter the Gateway number for the MCII-
e System Controller.

NOTE: If the MCII-e will communicate with hosts outside its network, enter 
the IP address of a host or router which will serve as the Gateway. Otherwise, 
if the MCII-e only needs to communicate with the local network, leave the 
Default Gateway field at its default setting (0.0.0.0).

The Default Gateway is normally configured the same on both the active and 
standby MC-II-e System Controller Cards.

The same screen you use to set the network settings can be used to view the 
settings as well. You must be connected using a serial connection via J1 to 
make changes, but you can view them with any type of AZedit connection (J1, 
J9, J10, or Ethernet).
19
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6. Click Apply.

7. Click Close.
The Ethernet Setup window is closed.

8. Connect the MCII-e System Controller to your network with an Ethernet cable.

NOTE: The unique Ethernet MAC address assigned to each MCII-e card during manufac-
turing is displayed in the field MAC Address. It is NOT possible to modify this address.

9. Connect the PC to your network with an Ethernet cable.

NOTE: If you do not know these numbers, your system administrator can give you the IP 
Address and Netmask to use.

Once you have entered the IP Address and Network Mask, do the following:

1. From the Options menu, select Communications.
The Communication screen appears

2. In the Connection area, select the Network radio button.

3. In the IP Address field, either enter the MCII-e IP Address you wish to connect with, 

or click the Search button . The search button scans the network for any MCII-e 
devices. If multiple units are on the network, each will appear in the list. 



Download Firmware for the MCII-e System Controller
4. Select the MCII-e System Controller you wish to work with.

5. Click OK.
The Communications screen closes. The IP Address is configured in AZedit for the MCII-e 
System Controller.

Download Firmware for the MCII-e System Controller

WARNING: The following procedure will cause one or more brief disruptions in intercom 
communications. Also, SAVE your intercom system configuration. From the File menu, select 
SAVE. Later, if you need to restore the intercom configuration from disk, use Send File in the 
Online Menu.

Before you begin, be sure to verify that SERVER mode has been disabled. Also, it is extremely 
important to take the Standby Controller card out of the frame, if one is installed.

NOTE: The Active Master Controller will have the topmost red LED (#23) on in the status 
window lit.

To download master controller firmware, do the following:
21
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1. From the Status Menu, select Software Versions.
A popup list appears.

2. From the Software Versions popup list, select Master Controllers.
The Master Controller Version Information screen appears.

3. Right-click the active Master Controller, and then select Download Firmware.
The Firmware Download screen appears.

NOTE: You can also press Ctrl+Shift+D to open the Firmware Download screen once 
the Master Controller is highlighted.

4. From the Firmware Download screen, select the firmware update file. Or use the 
browse button to navigate where the new file resides.

5. Click Open.
The firmware update appears in the Download Firmware screen.

6. Click Begin Download.
This process can take as little as 30 seconds with “Fast Ethernet” or as long as five 
minutes when using a serial connection at 9600 baud.

NOTE: If there is any disruption in the communications link during the download, you 
will get an error message. In this case, repeat the download.

7. When the file has been completely downloaded, the MCII-e System Controller will 
begin processing the update.

IMPORTANT! Any disruption at this point, such as loss of power, removing or resetting 
cards may result in Master Controller failure. If this happens, you will have to return the 
affected unit for replacement or repair.

The AZedit session goes offline for 15-20 seconds when the card performs a reset. It auto-
matically will reconnect when it is finished.

When the Master Controller is finished, the new software version will appear in the ver-
sion field of the Version Status screen.

If you do not have a Standby Master Controller Card, you can skip steps eight and nine.

8. Once the Active Master Controller is updated, remove it from the frame.

9. Insert the Standby Master Controller and repeat steps three through eight.

10. When the Standby Master Controller is finished, insert both controllers and resend 
your system setup file.



Download Firmware for the MCII-e System Controller
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CHAPTER 3

Accessories
In this chapter

• Accessories

• AZedit

• UIO-256

• PAP

• LCP

• General Purpose
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Accessories

NOTE: AZedit sessions are only enabled on J9 or J10 when the advanced communication 
boxes are enabled from “communications” screen and the correct baud rates are config-
ured.

XCP-ADAM-MC Master Controller Breakout Panel

The XCP-ADAM-MC Breakout Panel allows many different peripherals to be connected 
to the master controller of an ADAM Intercom System, such as AZedit, trunking systems, 
UIOs, PAPs, LCPs, GPI/Os, etc. For the breakout panel pinouts, see pages 9-15.

AZedit

AZedit is a Windows®-based, full-featured configuration software, providing online and 
offline configuration capabilities. It gives you the ability to manage multiple intercom sys-
tems, assign and reassign users to different ports, as well as dynamically add hardware to 
your system setup without jumper changes, rewiring, or taking the system offline. AZedit 

figure 1. Connection Diagram. The 68-pin SCSI can be attached to the
XCP-ADAM-MC.



Accessories
has the capability to load pre-set configuration files, which means configurations saved to a 
disk can be uploaded to the “live” application at anytime, without interruption.

The XCP-ADAM-MC breakout panel has three DB-9 connectors that can be used to connect to 
AZedit (AZedit #1, #2, and #3).

Trunking Systems

The RTS™ Trunking System manages intercommunications between separate intercom sys-
tems using intercom ports that have been reserved and interconnected between the intercom 
systems with devices in other frames. Keypanels or other data devices can then communicate 
with devices in other frames.

UIO-256

Each UIO-256 provides 16 GPI inputs and16 GPI outputs. The GPI inputs can be used just like 
keypanel keys to activate intercom ports, party lines, relays, etc. Each relay output provides a 
choice of normal open and normal closed contacts. The relays can be assigned for activation 
from keypanel keys, and can be used to control lighting, or to key remote transmitters, paging 
systems, etc.

PAP

Program Assist Panels provide a fast and easy method of selecting any of several program 
sources (connected to input ports of the intercom system) for use with the IFB outputs feature 
of the intercom system.

LCP

The LCP panel (Level Control Panel) combines the functionality of three products into one. 
The LCP allows you to adjust analog input and output gains, assign sources to IFB outputs and 
make changes on the fly, and to add members to a party line on the fly.

GPI/O (General Purpose Input/Output)

J11 provides 8 general purpose control inputs and 8 general purpose control outputs. The con-
trol inputs can be used just like keypanel keys to activate intercom ports, party lines, relays, 
etc. The control outputs are open-collector, active-low outputs. They can be activated by key-
panel keys and can be used to control lighting, to key a remote transmitter, to activate a paging 
system, etc.

Pin-outs for the digital inputs and outputs are summarized in the table on page 15. 
27
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CHAPTER 4

Trunking and the MCII-e System
In this chapter

• Enable Trunk Support for MCII-e System Controller Card

• Connect MCII-e to the Trunk Master (Data)

• Configure TrunkEdit and AZedit to Communicate with the MCII-e System Controller 
Card
29
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Trunking and the MCII-e System Controller

Trunking allows one intercom system to communicate with another remote intercom sys-
tem with devices in other frames. For example, a user in New York can talk to a user in 
Los Angeles if the systems they are using are trunked together. Trunking can be config-
ured to work with cables, fiber optics, voice over internet protocol, or any form of audio/
data transfer media, to allow communication between systems. 

To trunk the MCII-e System Controller Card, do the following:

1. From the AZedit main menu, select Options.
The Options sub-menu appears.

2. From the Options sub-menu, select Preferences.
The Applications Preferences screen appears.

3. On the Applications Preferences screen, click the Advanced tab.
The Advanced screen appear.

4. On the Advanced screen, select Enable trunking support.

5. Click OK to save the change and close the screen. Or, click Apply to save the change 
and leave the screen open.

When your system has limited bandwidth, you want to set the Allow for Remote Trunk 
Master. By setting this option, the baud rate is changed to 9600 baud, instead of the 
default, 38.4K.

To enable the Remote Trunk Master, do the following:

WARNING!: Enabling this option will cause the system to reset. All data will be 
erased in the frame. Be sure to save your system setup to disk before performing this 
task.

1. Remove the Standby Master Contoller.

2. From the AZedit main menu, select Options.
The Options sub-menu appears.

3. From the Options sub-menu, select Intercom Configuration.
The Intercom Configuration screen appears.

4. On the Intercom Configuration screen, click the Options tab.
The Options screen appears.

ENABLE TRUNK SUPPORT IN AZEDIT



Trunking and the MCII-e System Controller
5. On the Options screen, select Allow for remote trunk master.

6. Click Test to verify the intercom will accept the new settings.

7. Click Apply.
The intercom will stop communicating with AZedit, reconfigure itself, and then reset.

8. Resend the current setup.

9. Replace the standby controller.
It will automatically reconfigure itself to match the new settings.

To connect MCII-e to the Trunk Master, do the following:

1. Connect the MCII-e System Controller Card data connector to one of the eight DB-9 con-
nections on the ICP-2000.

To setup the TrunkMaster to be able to communicate with MCII-e, do the following:

1. Open TrunkEdit.

2. In the left navigation, open the Intercom slide screen.
The Intercom navigation panel displays.

3. From the Intercom navigation, select Setup.
The Intercom Setup screen appears.

4. In the Intercom Setup screen, enter the Intercom System Name (i.e.; ADAM) in the 
appropriate ICOM port (for example, if the MCII-e System Controller is cabled to the ICP-

CONNECT THE MCII-e TO THE TRUNK MASTER (DATA)

CONFIGURE THE TRUNKMASTER TO COMMUNICATE WITH 
THE MCII-e SYSTEM CONTROLLER CARD
31
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2000’s J4 connector, then in the Intercom Setup screen, enter the MCII-e’s machine 
name in the line which corresponds with the COM port #4 field).

5. Select the Baud Rate field and enter the baud rate to match the baud setting of the 
Intercom Trunking port (38.4K or 9600).

6. When you are finished, click the Send button to send the changes to the Trunk Master. 
When the changes are sent to the Trunk Master, the MCII-e connects to the Trunk Mas-
ter and uploads the remote ports. Once the MCII-e has uploaded this data, it sends its 
port alphas to the Trunk Master.

In AZedit

1. Open AZedit.

2. On the main screen, select the port you want to make available remotely..

3. In the Scroll Enable field, select Trunk and AZedit.
By enabling Trunk and AZedit on this port, remote users will display in AZedit and 
remote keypanel users will be able to see enabled ports.

4. Send the changes to AZedit.

In TrunkEdit - Define the trunk line

NOTE: We recommend that you only enable user positions that will be used by 
remote systems.

NOTE: We recommend you map out your system before defining the trunk lines.



Trunking and the MCII-e System Controller
Defining the trunk line shows where a trunk line begins and ends, as well as shows the audio 
connections between frames.

To define trunk lines, do the following:

1. Open TrunkEdit.

2. In the left navigation, open the Trunk slide screen.
The Trunk Definitions for: All Intercoms panel displays.

3. In the ICOM 1 field, enter the intercom name of one end of the trunk connection (i.e.; 
ADAM).

4. In the Port Field, enter the port number where ICOM1 is assigned (i.e.; N014). Or, in the 
Alpha field, enter the Alpha of the ICOM1 system (i.e.; N014).

5. In the ICOM2 field, enter the name of the system ICOM1 is linked to (i.e.; INT1).

6. In the Port field, enter the port number where ICOM2 is assigned (i.e.; N005). Or, in the 
Alpha field, enter the alpha of the ICOM2 system.

7. Once finished with all your definitions, Send the changes to the TrunkMaster.

In AZedit

Once you are finished defining the trunk lines of your system, you can use AZedit to make key 
assignments for the keypanels. With Trunking enabled, you will be able to see all trunked sys-
tem and their ports enabled in AZedit.
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